PowerPoint 2007

THE MISSING MANUAL®

“The Missing Manual series is simply the most intelligent and usable series of guidebooks…”
—Kevin Kelly, cofounder of Wired

The book that should have been in the box

E.A. Vander Veer
Answers found here!

*PowerPoint 2007: The Missing Manual* offers complete coverage of PowerPoint’s dazzling new look and dramatically new way of doing things. With a unique and witty style that helps you learn quickly, this entertaining book doesn’t just explain how every feature works—it shows you which tools to use and which to avoid.

The important stuff you need to know

- Learn how to navigate PowerPoint using the *ribbon*—the new tabbed toolbar.
- Create basic slideshows by adding text, charts, diagrams, and tables.
- Run presentations on computers, overhead projectors, or on the Web.
- Go beyond bullet points—add pictures, voice-overs, and video clips.
- Collaborate with others using digital sticky notes and other sharing tools.
- Learn how PowerPoint can *support* your presentation—not *be* your presentation.

People learn best when information is engaging, clearly written, and funny. Unfortunately, most computer books read like dry catalogs. That’s why I created the Missing Manuals. They’re entertaining, unafraid to state when a feature is useless or doesn’t work right, and—oh, by the way—written by actual writers. And on every page, we answer the simple question: “What’s this feature for?”

David Pogue is a *New York Times* technology columnist, bestselling author, and creator of the Missing Manual series.
PowerPoint 2007

E. A. Vander Veer
Table of Contents

The Missing Credits ................................................................. xiii
Introduction .................................................................................. 1

Part One: Slideshow Basics

Chapter 1: Creating a Basic Presentation................................. 19
  Beginning a New Presentation .......................................................... 19
  Creating a New Presentation from Scratch ...................................... 20
  Creating a Presentation from an Existing Template, Theme, or Presentation ......................................................... 22
  Choosing a Theme for Your Presentation ........................................... 32
  Adding Text .................................................................................. 34
    Adding Text to an Existing Text Box .............................................. 34
    Adding a New Text Box ............................................................... 36
  Adding More Slides ........................................................................ 38
  Moving Around Inside a Presentation ............................................. 39
    Navigating with the Scroll Bar .................................................... 40
    Navigating with the Slides and Outline Tabs ................................. 40
    Using Find ................................................................................ 42
  Adding Speaker Notes ...................................................................... 43
  Creating and Printing Handouts ..................................................... 44
  Saving and Closing a Presentation .................................................. 46
  Running a Presentation ................................................................... 47
## Chapter 2: Editing Slides ................................................................. 51
- Editing Text ................................................................................. 51
  - Selecting Text ........................................................................ 52
  - Cutting Text ........................................................................... 53
  - Copying Text .......................................................................... 54
  - Pasting Text ........................................................................... 54
  - Moving Text ........................................................................... 57
  - Deleting Text .......................................................................... 57
- Reversing an Action (Undo) ......................................................... 58
- Finding and Replacing Text Automatically .................................. 58
- Spell Check and Other Editorial Tools ........................................ 60
  - Checking Spelling .................................................................... 61
  - Thesaurus ................................................................................. 67
  - Translating Words into Other Languages ................................ 69
  - Researching Stuff .................................................................... 69
  - Turning on AutoCorrect (for Capitalization and Spelling) ........ 71
  - Adding Special Characters ..................................................... 74
  - Non-English Text ..................................................................... 75

## Chapter 3: Formatting and Aligning Your Text ............................. 77
- Automating Text Formatting ....................................................... 77
  - Using AutoFormat .................................................................... 79
  - Using AutoFit ........................................................................... 81
- Manually Formatting Text Appearance ........................................ 83
  - Changing the Font .................................................................... 85
  - Changing Font Size ................................................................... 86
  - Bolding, Italicizing, and Underlining Text ............................... 89
  - Changing Text Color and Background Color ......................... 90
  - Adding Special Color Effects ................................................... 91
  - Tweaking the Text Outline ...................................................... 97
  - Adding Special Text Effects ..................................................... 101
- Manually Aligning and Indenting Text ......................................... 104
  - Aligning Text and Creating Columns ....................................... 104
  - Creating Lists .......................................................................... 108
  - Changing Indents ...................................................................... 113
  - Changing Tab Stops .................................................................. 114
  - Changing Spacing ..................................................................... 116
  - Changing Text Direction ......................................................... 118
- Formatting Text Boxes ............................................................... 120

## Chapter 4: Formatting and Laying Out Your Slides ....................... 123
- Changing Slide Layout ............................................................... 123
  - Applying a Canned Layout ....................................................... 124
  - Switching Between Portrait and Landscape (and Back) ............ 125
  - Repositioning Text Boxes ....................................................... 126
  - Help for Positioning Text Boxes: Zoom, Guides, and Grid ........ 128
Chapter 5: Editing Your Slideshow .........................................................141
Viewing Multiple Slides ...........................................................................141
Slides Pane ..............................................................................................142
Slide Sorter View ....................................................................................143
Adding, Deleting, and Moving Slides .....................................................143
Adding Blank Slides ................................................................................144
Deleting Slides .........................................................................................145
Moving Slides .........................................................................................146
Duplicating Slides ...................................................................................147
Cutting, Copying, and Pasting Slides ......................................................148
Inserting Slides from Other Slideshows ................................................148
Editing Slide and Layout Masters ..........................................................151
Creating Slide Masters and Layout Masters .........................................157
Creating a New Slide Master .................................................................158
Renaming Slide Masters and Layout Masters .......................................159
Preserving Slide Masters and Layout Masters ....................................160
Applying Multiple Slide Masters ..........................................................162
Editing Handout Masters ......................................................................162
Editing the Notes Master .......................................................................165
Adding Headers and Footers ..................................................................167
Adding Footers to Your Slides ...............................................................168
Adding Headers and Footers to Notes Pages and Handouts ...............169

Chapter 6: Adding Charts, Diagrams, and Tables .................................171
Creating Charts .....................................................................................172
Choosing a Chart Type ..........................................................................173
Creating a Chart .....................................................................................175
Customizing Charts with Prebuilt Layouts and Styles .........................178
Editing and Tweaking Charts ...............................................................181
Pasting Existing Charts into PowerPoint ...............................................191
Creating Diagrams ................................................................................193
Adding Diagrams to Slides .....................................................................194
Turning Lists into Diagrams .................................................................195
Applying Prebuilt Styles and Color Themes to Diagrams .....................197
Tweaking Diagrams ...............................................................................198
Adding, Changing, and Moving Diagram Shapes ..................................200
Changing Diagram Text ..........................................................................203
Changing Background Color ..................................................................129
Adding a Gradient Effect .......................................................................133
Reapplying Themes, Colors, and Fonts ...............................................136
Reapplying a Theme ..............................................................................136
Reapplying a Color Scheme .................................................................138
Reapplying a Font ..................................................................................139
Part Two: Presenting Your Slideshow

Chapter 7: Delivering Presentations ...................................................... 221
  Setting Up a Slideshow ........................................................................ 221
  Choosing a Slideshow Mode ................................................................. 222
  Hiding Individual Slides .................................................................... 225
  Matching Your Slideshow to Your Monitor ........................................ 227
  Setting Up a Speaker Notes Screen ..................................................... 227
  Setting Up Automatic Timing ............................................................... 227
  Looping Continuously ....................................................................... 229
  Recording Voiceover Narration ......................................................... 230
  Turning Off Sounds and Animations .................................................... 233
  Slideshows for Multiple Audiences .................................................... 233
  Creating a Custom Slideshow .............................................................. 234
  Editing a Custom Slideshow ............................................................... 236
  Presenting Your Slideshow ................................................................. 237
  Drawing on Slides During a Presentation ............................................ 239
  Creating PowerPoint Shows ............................................................... 241
  Emailing Your Presentation ............................................................... 243
  Packaging Presentations for CD ........................................................ 243
  Presentations over the Web ............................................................... 247
  Converting Your Presentation into One or More Web Pages .............. 248
  Converting to Other Formats ............................................................ 251
  Optimizing Presentations ................................................................. 255
    Go Easy on the Bling ...................................................................... 256
    Pare Down Objects Outside of PowerPoint ....................................... 256
    Choose Insert over Dragging or Pasting ........................................... 257
    Recycle Your Images ...................................................................... 257
    Get Rid of Invisible Stuff ................................................................. 257
    Compress Your Images ................................................................... 259
    Don’t Embed Fonts (but if You Have to, Do so Wisely) ...................... 261
    Download and Install an Optimization Program .............................. 262

Chapter 8: Printing Presentations ......................................................... 265
  Printing Slides (One Slide per Page) .................................................. 266
  Handouts (Multiple Slides per Page) ................................................... 270
  Overhead Transparencies ................................................................... 274
Chapter 10: Adding Sound and Video ................................................................. 325
  Adding Sound ........................................................................................................ 325
  Sound File Formats You Can Use in PowerPoint ................................................ 327
  Inserting a Sound Clip from Your Computer ...................................................... 327
  Adding a Sound Clip from the Clip Organizer .................................................... 331
  Adding a Sound Clip from an Audio CD ............................................................... 332
  Recording and Adding Your Own Sound Clip .................................................... 335
  Creating a Soundtrack .......................................................................................... 336
  Making Sound Clips Presenter-Triggered ............................................................ 336
  Adding Video .......................................................................................................... 337

Chapter 11: Slide Transitions and Animated Effects ............................................. 343
  Slide Transitions .................................................................................................. 344
    Types of Transitions ........................................................................................... 344
    Adding Transitions Between Slides .................................................................... 345
  Custom Animations ............................................................................................... 349
    Applying Entrance Effects .................................................................................. 350
    Applying Emphasis Effects .................................................................................. 357
    Applying Exit Effects .......................................................................................... 359
    Motion Path Effects ........................................................................................... 359
    Changing Effects .................................................................................................. 365
    Deleting an Effect ................................................................................................ 366
    Managing Multiple Effects .................................................................................. 366

Chapter 12: Make Your Slides Clickable ............................................................... 371
  Adding Links .......................................................................................................... 374
    Linking to Another Slide in the Same Slideshow .............................................. 374
    Linking to a Slide in Another PowerPoint Slideshow ....................................... 374
    Linking to a Web Page ......................................................................................... 375
    Creating (and Linking to) a New Document ...................................................... 378
    Linking to an Email Address .............................................................................. 380
    Adding Screen Tips (Hover Text) to Links ....................................................... 381
  Adding Actions ...................................................................................................... 381
    Adding Actions to Text or Images ...................................................................... 382
    Adding Action Buttons ....................................................................................... 384
  Editing Links and Actions .................................................................................. 387
    Editing Links ....................................................................................................... 387
    Edit Actions ......................................................................................................... 388
    Deleting Links and Actions ............................................................................... 388
Part Four: Working Faster and More Effectively

Chapter 13: Customizing PowerPoint ................................................... 391
Customizing How PowerPoint Looks ............................................................ 392
    Choosing an Overall Look .......................................................................... 392
    Show (or Hide) the Mini Toolbar ................................................................. 392
    Show (or Hide) the Ribbon .......................................................................... 394
    Show (or Hide) the Developer Tab .............................................................. 394
    Select a Theme for All New Slideshows ..................................................... 394
    Customize the Quick Access Toolbar ....................................................... 395
    Customize the Status Bar .......................................................................... 401
Customizing How PowerPoint Behaves .......................................................... 401
    Open All Documents in a Certain View ...................................................... 402
Saving Files: How, Where, and How Often .................................................. 402
Printing ......................................................................................................... 404
Optimizing PowerPoint Files ......................................................................... 405
Security ........................................................................................................ 406
Editing and Proofing .................................................................................... 408
Displaying the Clipboard ............................................................................. 409
Choosing a Standard Chart Type ................................................................... 409
Customizing the Way Your Slideshows Run .................................................. 410
    Show (or Hide) “Ghosted” Navigational Controls ...................................... 411
    Show (or Hide) the Right-Click Menu ....................................................... 411
    Give Yourself the Option to Keep Ink Annotations .................................... 413
    Tell PowerPoint to End Slideshows with a Black Slide (or Not) ................. 413
Installing Add-Ins ......................................................................................... 414

Chapter 14: Macros: Putting Slideshows on Autopilot.........................417
Creating and Editing Macros .......................................................................... 418
    Creating a Macro .......................................................................................... 418
    Opening a Macro for Editing ...................................................................... 421
Running Macros ............................................................................................ 422
    Setting Security Options ........................................................................... 422
    Testing a Macro .......................................................................................... 424
    Adding a Macro to a Slideshow ................................................................... 425

Chapter 15: Collaborating with Others.................................................429
Preparing for Collaboration .......................................................................... 430
Sending Out a File for Review ..................................................................... 432
    Emailing Using Outlook ............................................................................. 433
    Emailing Using Other Programs ............................................................... 433
Reviewing with Comments .......................................................................... 434
    Adding a Comment ...................................................................................... 435
    Reading Comments ..................................................................................... 436
Editing Comments ............................................................................................................................ 436
Deleting Comments .......................................................................................................................... 437
Finalizing Presentations ...................................................................................................................... 437
SharePoint and Groove ....................................................................................................................... 439
  SharePoint ......................................................................................................................................... 439
  Groove ............................................................................................................................................... 440
Security .............................................................................................................................................. 440
  Creating Hard-to-Edit Versions of Your File .................................................................................... 440
  Password-Protecting Your File ......................................................................................................... 441
  Attaching Digital Signature to Files .................................................................................................. 444
  Using Information Rights Management ............................................................................................ 447

Part Five: Appendix

Appendix: Getting Help ..................................................................................................................... 451
Index .................................................................................................................................................. 457
The Missing Credits

About the Author

E. A. Vander Veer started out in the software trenches, lexing and yaccing and writing shell scripts with the best of them. She remained busy and happy for years writing C++ programs and wresting data from recalcitrant databases until reaching the proverbial fork in the road, when she chose the dark path—marketing. After a stint as an Object Technology Evangelist (yes, that’s an actual job title), she found a way to unite all of her passions: writing about cool computer stuff in prose any human being can understand. Books followed—over a dozen so far—including *Flash 8: The Missing Manual*, *JavaScript For Dummies*, *XML Blueprints*, and the fine tome you’re holding right now. Her articles appear in online and print publications including Byte, CNET, Salon.com, WEBTechniques, CNN.com (and a bunch you’ve never heard of). She lives in Texas with her husband and daughter. Email: emilyamoore@rgv.rr.com.

About the Creative Team

Nan Barber (editor) has worked with the Missing Manual series since its inception—long enough to remember booting up her computer from a floppy disk. Email: nanbarber@oreilly.com.

Peter Meyers (editor) works as an editor at O’Reilly Media on the Missing Manual series. He lives with his wife and cats in New York City. Email: peter.meyers@gmail.com.

Michele Filshie (copy editor) is O’Reilly’s assistant editor for Missing Manuals and editor of *Don’t Get Burned on eBay* (O’Reilly). Before turning to the world of computer-related books, Michele spent many happy years at Black Sparrow Press. She lives in Sebastopol. Email: mfilshie@oreilly.com.

Echo Swinford (technical reviewer) has spent 10 years in the medical presentations and education industry. She’s currently finishing her Master’s degree in New Media at the Indiana University-Purdue University Indianapolis School of Informatics. Her first book, *Fixing PowerPoint Annoyances*, was published by O’Reilly Media in February 2006, and she has a string of tech editing credits with other publishers. Echo has been a Microsoft PowerPoint MVP since early 2000. She can be contacted for projects and consulting at freelance@echosvoice.com.

easy computing
Geetesh Bajaj (technical reviewer) has been designing PowerPoint presentations and templates for over a decade and heads Indezine, a presentation design studio based out of Hyderabad, India. His indezine.com site attracts nearly a million page views each month, and it has hundreds of free PowerPoint templates and other goodies for visitors to download. In addition, Geetesh also issues a biweekly PowerPoint newsletter on indezine.com that has tens of thousands of subscribers.

Acknowledgements

It takes a team of dedicated, hardworking professionals to turn any manuscript into a finished book, and the O’Reilly team is one of the best in the business. Extra thanks go out to Nan Barber, whose competence, surefootedness, and directness make her the kind of editor every author dreams of; Echo Swinford and Geetesh Bajaj, whose experience and dead-eye accuracy helped shape this book immeasurably; and Pete Meyers, who made sure the trains ran on time (while still managing to be a genuinely nice guy).

The Missing Manual Series

Missing Manuals are witty, superbly written guides to computer products that don’t come with printed manuals (which is just about all of them). Each book features a handcrafted index and RepKover, a detached-spine binding that lets the book lie perfectly flat without the assistance of weights or cinder blocks.

Recent and upcoming titles include:

Access 2007: The Missing Manual by Matthew MacDonald
AppleScript: The Missing Manual by Adam Goldstein
AppleWorks 6: The Missing Manual by Jim Elferdink and David Reynolds
CSS: The Missing Manual by David Sawyer McFarland
Creating Web Sites: The Missing Manual by Matthew MacDonald
Dreamweaver 8: The Missing Manual by David Sawyer McFarland
eBay: The Missing Manual by Nancy Conner
Excel 2003 for Starters: The Missing Manual by Matthew MacDonald
Excel 2003: The Missing Manual by Matthew MacDonald
Excel 2007 for Starters: The Missing Manual by Matthew MacDonald
Excel 2007: The Missing Manual by Matthew MacDonald
FileMaker Pro: The Missing Manual by Jeff Coffey and Susan Prosser
Introduction

If you’ve never seen a PowerPoint presentation, you’re in a pretty select group. With legions of folks all over the world pounding out an estimated 30 million PowerPoint slides every day, PowerPoint’s the runaway leader in the field of presentation programs, leaving competitors like Corel Presentations and Apple’s Keynote in the dust. PowerPoint has become so ubiquitous that it’s even managed to work its way into the English language: powerpointless, as many audience members can attest, describes a PowerPoint presentation that has bulleted text, graphics, animated slide transitions—everything except a good reason for existing.

So how do you improve a program that’s wildly successful? If you’re Microsoft, you completely redesign it. That’s right: PowerPoint 2007 looks completely different from its previous incarnation, PowerPoint 2003. Gone are the menus, wizards, and most of the toolbars and panes that a generation of PowerPointists grew up with. As you see in Figure I-1, Microsoft has replaced all of that with the ribbon. And that’s just the tip of the redesign iceberg.

The good news is you can still do the same things in PowerPoint 2007 that you could do in earlier versions—and a few more, besides. You can still create slideshows that contain bulleted lists, sound and video clips, and cool animated effects. You can still add macros and interactive buttons to your slides, and you can still deliver your slideshows in person, over the Web, or on an unattended kiosk. What’s new in PowerPoint 2007 is how you do all of these things.

Fortunately, you’re holding the book that Microsoft should have included in the PowerPoint 2007 box—but didn’t. If you’re familiar with PowerPoint 2003 or an earlier version of the program, this book will help you make the transition from
the old, familiar way of doing things to the new, improved way. (You even see tips and tricks that were buried so deep inside menus and toolbars in PowerPoint 2003 that you probably didn’t know they were there.)

On the other hand, if you’re brand new to PowerPoint—or even to presentation programs in general—then you’re in luck, because this book shows you how to build basic to bowl-’em-over presentations for work, school, civic organizations, or anything else you’re involved in.

**FROM THE FIELD**

**Presentation vs. Slideshow**

Microsoft’s help files, as well as most PowerPoint books, use the terms *presentation* and *slideshow* interchangeably. But a very important distinction exists between the two.

A *slideshow* is a collection of slides but a *presentation* is everything that goes into delivering the slideshow to your audience. A presentation includes not just the slideshow, but speaker notes, printed handouts, and—most important of all—you, the presenter.

In other words, no matter how cool your slides are, they aren’t your presentation. Your slides are nothing more than tools you use to deliver your message. If you keep this distinction in mind, you’ll keep your focus on the message—where it belongs—and off the tricky stuff you can do with PowerPoint. For your audience’s sake, avoid bringing yet another powerpointless presentation into the world!
What You Can Do with PowerPoint 2007

PowerPoint was originally designed to help business professionals create and deliver electronic slideshows (sales presentations, mostly). But over the years, as Microsoft piled on the options, folks began discovering new ways to use the program.

Here’s a short list of what you can create using PowerPoint 2007:

- **Multimedia presentations.** Use PowerPoint to create slideshows that you—the presenter—can run in front of an audience on a computer screen (for small groups) or a digital projector (for a packed conference hall). The kinds of presentations that fit into this group include business and sales presentations, workshop and conference sessions, academic lectures, in-class reports, courtroom summations, and church choir programs. The sky’s the limit. Anytime you need to stand in front of a group and present information, you can use a PowerPoint slideshow to get your point across.

- **Kiosk presentations.** Presentations that run unattended, with a voiceover soundtrack, are perfect for trade shows, department store product demonstrations, Web sites, doctor’s offices—even (believe it or not) weddings and funerals.

- **Interactive and Web-based tutorials, quizzes, games, and more.** By adding buttons, links, and VBA macros, you can turn a static presentation into an interactive, audience-driven program much more quickly than you could by programming it from scratch. Examples of the kinds of interactive programs you can create with PowerPoint include CD/DVD and Web-based tutorials, training presentations, quizzes, games, and even software prototypes. (In fact, Microsoft’s designers used PowerPoint to create their prototypes of the new Office 2007 interface.)

- **Printed documents.** It’s not a full-fledged page-layout program like QuarkXPress, but PowerPoint 2007 comes with templates for popular printables (like certificates of achievement and calendars). It also gives you more control over layout than earlier versions of the program.

- **Web pages.** Although PowerPoint was never a serious contender in the Web site-creation market—and although support for creating Web pages has actually been downplayed in this version of the program—you can still optimize and save your slides as Web pages directly from PowerPoint.

- **Graphics and animations.** Compared to top-notch graphics and animation programs, the images and effects you can produce with PowerPoint 2007 may seem limited and clunky. Still, if PowerPoint’s all you’ve got to work with—and if you want to create a basic picture or animation—PowerPoint 2007’s got your back.
Introduction

What's New in PowerPoint 2007

Nearly all the changes Microsoft made to PowerPoint 2007 affect the way the program looks and behaves; in other words, the changes affect how you do things in PowerPoint 2007. The most sweeping of these include:

- A completely redesigned interface. The difference you notice right away is the tabbed ribbon (Figure I-2), which replaces all of the old, pre-PowerPoint 2007 menus and toolbars. Instead of wasting time trying to remember if the option you want is hiding on a toolbar or a menu or a pane or a dialog box or somewhere else entirely, in PowerPoint 2007, you reach all options from the ribbon.

FROM THE FIELD

When Not to Use PowerPoint

It's easy to get caught up in all the trappings associated with giving a presentation: the slideshow, the handouts, the speaker notes, and so on. But you can give a fantastic, memorable presentation without any of these supporting tools. You—what you have to say and how you say it—are the reason people are filing into the room, not the groovy tent cards you figured out how to print in PowerPoint.

In fact, when supporting tools cause you to lose focus and spend more time tweaking fonts than sharpening your logical thrusts and persuasive parries, you’re doing more than just wasting your time: You’re actually detracting from the overall effectiveness of your message. PowerPoint’s supposed to support your presentation, not be your presentation.

So before you even fire up the program, ask yourself these questions:

- **Do I really need slides?** PowerPoint slides are great for keeping key points (“Our company’s going down in flames”) in front of your audience during your presentation. They are also great for making direct appeals (“Please be happy with your 50 percent pay cut”). What they are not good for is delivering a bunch of dense information, such as the in-depth analysis of the last five years’ worth of sales activity that led to your conclusion. Also, when you need to make only a couple of points, you may be better off writing them on a whiteboard than using PowerPoint. Murphy’s Law applies double when you’re in front of a crowd: Anything that can go wrong (computer glitch, loose cable, burned-out projector bulb, keyboard lock-up) will go wrong. Less technology always translates to fewer headaches, even with a relatively mature and stable program like PowerPoint.

- **Do I really need speaker notes?** PowerPoint gives you a way to associate notes with your presentation that only you get to see. If you’re planning to deliver a lengthy presentation, having your speaker notes cued up to match your slides can save you lots of hair-pulling. But if you’re planning a short presentation, you know your material backwards and forwards, or you simply prefer to use 3 × 5 cards to jog your memory, then speaker notes may not be worth the time it takes to set them up.

- **Do I really need handouts?** In PowerPoint, handouts are nothing more than printouts of your slides (although Chapter 7 shows you how to beef up your handouts into something your audience will actually find useful). Use handouts when you want to leave lots of specific instructions or actionable items with your audience. If that’s not the case, skip the handouts (most of them end up in the circular file the minute the presentation’s over anyway).
**Note:** The Nostalgia Corner sidebars scattered throughout this book alert you to specific changes between PowerPoint 2003 and PowerPoint 2007.

- **New file formats.** The files you’ll create in PowerPoint 2007 bear a different file extension than the ones you created in earlier versions of the program. The good news is that the new XML-based file formats tend to be smaller and more recoverable than the old ones. The bad news is that you can’t edit PowerPoint 2007 files in an earlier version of the program unless you download and install a special converter program (page 12 has details).

- **Tighter integration among Office programs.** Microsoft gave all of the Office programs a face lift, not just PowerPoint. The result is that all Office programs share similar elements. The Office button (the old File menu) appears in the same spot in all Office programs; the steps you take to customize an Office program are the same; and certain options—like the ones you use to create charts and diagrams—look and behave pretty much the same way in PowerPoint as they do in Word and Excel.

- **Improved graphics.** All Office programs share a single, new-and-improved graphics engine that not only makes the charts, diagrams, and other visuals you create in PowerPoint look better (*much* better), but makes them easier to create, too (page 282).

- **More look-and-feel options.** PowerPoint 2007 comes with more and better-looking templates than earlier versions of the program. In addition, PowerPoint 2007 lets you create your own reusable custom slide layouts.

- **A new way to track revisions.** Unfortunately, unlike earlier versions of the program, PowerPoint 2007 doesn’t let you track the changes your reviewers make to your presentation files. For that, you need to buy yet another Microsoft product called SharePoint (page 439).
A Quick Tour of the New Interface

If you’re familiar with PowerPoint 2003, the first sight of PowerPoint 2007 might make you want to run away screaming. Where are the menus? Where are the toolbars? Where’s the Getting Started pane?

PowerPoint still has everything you need to create killer presentations. Stuff’s just organized differently. After you finish this section, you may even find you like the redesigned interface better than the original—especially if you take a few minutes to monkey around with PowerPoint while you’re reading. Remember, the new interface incorporates all the elements you know—buttons, menus, dialog boxes—they’re just in different places where, more often than not, you can get to them faster than before.

Ribbon

You can think of the ribbon as a big, fat, nonmovable toolbar. It may look as though it’s taking up an enormous amount of room on your screen (see Figure I-2), but it doesn’t take up any more space than the old menu bar plus a couple of toolbars. According to Microsoft’s side-by-side comparisons, a PowerPoint 97 document with all the toolbars visible actually appears more cramped (1008×575 pixels) than a PowerPoint 2007 document with just the ribbon showing (1024×573 pixels). And yet, the ribbon gives you access to every option available in PowerPoint.

Furthermore, the ribbon always appears in the same place, it never gets any bigger, and because you can’t customize the ribbon or reposition it the way you could toolbars in PowerPoint 2003, you can’t accidentally lose the ribbon.

Groups

When you launch PowerPoint, the Home tab automatically appears selected (Figure I-2), which displays text formatting options organized in sections, or groups. For example, options in the Font group of the Home tab let you bold and underline your text; options in the Paragraph group let you align your text and format it as a bulleted or numbered list.

Note: It may seem that Microsoft’s designers dropped the ball when they named the Home tab because the options it offers all relate to text. Naming it Slide Text would have made more sense. On the other hand, the ribbon’s first tab is called Home in all the Office 2007 programs, so there’s great consistency. The tools you use most often are in the same place in every Office 2007 program.

Command buttons

As you’d expect, to select one of the options on a ribbon, just click the button. To underline a heading, select the heading text you want to underline, zip to the Font group, and click the Underline button. To change the color of your text, first select it, and then head to the Font group of the Home tab and click the Font Color button.
A tiny down-arrow icon means you can click the arrow to see additional options. For example, clicking the down-arrow that appears beneath Paste (Figure I-2) displays a menu of paste-related options. Clicking the button (instead of the down-arrow next to it) lets you bypass the menu and go straight to the most popular menu command. Clicking the Paste button triggers the same result as choosing Paste ➝ Paste: Both immediately paste the contents of the Clipboard onto your slide.

**Dialog box launchers.** To give you complete control over every element of your slideshow while sticking to their design philosophy of offering all options on the ribbon, the PowerPoint 2007 designers placed a tiny dialog box launcher button in the bottom-right corner of many ribbon groups. When you click a dialog launcher, PowerPoint pops up a dialog box related to that group. Clicking the Font dialog box launcher (Figure I-2), for example, displays the Font dialog box in Figure I-3.

![Figure I-3: If you’re familiar with PowerPoint 2003, you’ll recognize the dialog boxes that let you customize every aspect of your slideshow.](image)

**Tabs**

Microsoft organized the ribbon’s tabs in the order they figured most people would create slideshows. They believe most folks begin by adding text to their slides, so they displayed the Home tab first, followed by the Insert tab (which lets you insert charts, diagrams, pictures, and other stuff), followed by the Slide Show tab (which lets you rehearse your timing and record voiceover narration), followed by the Review tab (which lets you spell-check your slideshow before sending it out for feedback).

*Note:* You don’t have to select tabs in order. Most people hop back and forth from tab to tab as they add additional text, pictures, and sounds to their slides and reform the existing material.
Colophon

Mary Brady was the production editor for *PowerPoint 2007: The Missing Manual*. Sanders Kleinfeld and Marlowe Shaeffer provided quality control. Dawn Mann wrote the index.

The cover of this book is based on a series design originally created by David Freedman and modified by Mike Kohnke, Karen Montgomery, and Fitch ([www.fitch.com](http://www.fitch.com)). Back cover design, dog illustration, and color selection by Fitch.

David Futato designed the interior layout, based on a series design by Phil Simpson. This book was converted by Lakshmi Sadasiv to FrameMaker 5.5.6. The text font is Adobe Minion; the heading font is Adobe Formata Condensed; and the code font is LucasFont’s TheSans Mono Condensed. The illustrations that appear in the book were produced by Robert Romano and Jessamyn Read using Macromedia FreeHand MX and Adobe Photoshop CS.